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Configurator Keyboard Shortcuts 

Module Objectives 

Upon completion of this module, you will be able to: 
1. Use the keyboard shortcut commands to navigate through the Configurator 

Keyboard Shortcut Commands 

To use a keyboard shortcut, press the following key combinations. When using the ‘Ctrl+’ keyboard 
shortcuts, hold down the Ctrl key, and then press the corresponding key to activate the shortcut. 
 
Notice that all the menus and many commands have one underlined character. Click Alt+underlined 
character in the menu caption to open the menu. A menu command can then be selected by pressing 
the underlined character for the desired command in the list. For instance, click ALT+F+S to save a 
Whiteboard. 

File Menu Shortcuts 
 Open New Advanced UI Whiteboard - Ctrl+N 
 Open whiteboard stored in local database - Ctrl+O 
 Close open whiteboard- ALT+F+C  
 Save whiteboard - Ctrl+S 
 Save whiteboard As - ALT+F+A 
 Save whiteboard Image - Ctrl+W 
 Print - ALT+F+P or Ctrl+P 
 Exit SBW - ALT+F+X 

Edit Menu Shortcuts 
 Cut - Ctrl+X 
 Copy - Ctrl+C 
 Paste - Ctrl+V 
 Delete - Del 
 Select All - Ctrl+A 
 Upgrade System - ALT+E+U 

View Menu Shortcuts 
 Detail - ALT+V+D 

• System Diagram - ALT+V+D+D  
• Connections Diagram - ALT+V+D+C 
• Hardware List - ALT+V+D+H 
• Upgrade View - ALT+V+D+U 

 Properties  
 Parts List - Ctrl+L 
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Insert Menu Shortcuts 
 System - ALT+I+S 
 Upgrade - ALT+I+U  
 Network - ALT+I+N 

Tools Menu Shortcuts 
 Options - ALT+T+O 

Window Menu Shortcuts 
 New Whiteboard - ALT+W+N 
 Cascade - ALT+W+C 
 Tile Horizontally - ALT+W+H 
 Tile Vertically - ALT+W+V 
 Arrange All - ALT+W+A 
 Close All - ALT+W+L 

Help Menu Shortcuts 
 Configurator Help Contents - F1 
 About the Configurator - ALT+H+A 

Moving Between Windows 

When you have more than one Whiteboard open in the Configurator, press CTRL+TAB to switch 
between open Whiteboards. 

Summary 

In this module, you have learned the following task: 
1. How to use the keyboard shortcut commands to navigate through the Configurator 
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SBW Configurator Message Notifications 

Module Objectives 

Upon completion of this module, you will be able to: 
1. Understand how the Gatekeeper works. 
2. Recognize and respond to the following message notifications: 

 Informational messages 
 Warning messages 
 Error messages 
 To-Do messages 

Gatekeeper 

The user must acknowledge certain messages generated in the Whiteboard before saving or converting 
to a quote.  There are the following four types of messages:  

 Errors 
 To Do’s 
 Warnings 
 Informational 

 
The Gatekeeper forces “acknowledgement” of all but the last type (Informational) of message 
notification. Note that you are not prevented from saving or quoting a configuration, but you must 
acknowledge that the configuration is in a state that may be an issue in the Quoter or for the factory. 
 
Messages are sequenced by severity and description.  Acknowledgement is done by clicking in the 
checkbox associated with each message.  Alternatively, all messages can be acknowledged by clicking 
the Acknowledge All Messages check box.  Once all messages are acknowledged, the Continue 
button is enabled, and you can save the configuration or convert it to a quote. 

Types of Message Notifications 

SBW is a rule-based configuration tool, so from time to time message notifications will appear. 
Following is a list of the messages and their meanings: 

Error Messages 
  Error Messages – SBW indicates a configuration error message in the message 

notification with a red exclamation point to indicate that if no action is taken there will be 
a configuration error.  
Error messages contain the following information: 

• Type - This shows the type of message you are receiving. 
• Message - This shows the message content. 
Click Continue to return to the application and continue the configuration process. 
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Figure 1: Error message notification 

To-Do Messages 
  To-Do Messages - Certain messages are not errors but reminder that there is 

something left to do on the configuration. For example, this kind of message occurs 
adding an empty disk array closure to the worksheet but before any disk drives are 
configured. These are “To Do” messages. On the Tools>Options Error Notification menu, 
one can set defaults for To Do just like the other Message Types. When the condition 
causing the To Do message has been met, it will be automatically deleted. See Figure 1 
below. 

Warning Messages 
  Warning messages - Warning message dialog boxes appear when an entry is 

incompatible with the current system.  The warning message dialog box may suggest 
compatible choices. Warning message dialog boxes appear when an entry is 
incompatible with the current system. The warning message dialog box suggests 
compatible choices. 

Note: When a message is followed by Configuration will halt; click OK to continue from 
the last time the configuration was applied, with changes still pending. 

 
Figure 2: Warning message notification 

Information Messages 
 Blue - Informational Messages - SBW displays informational messages when you 

have an option of what action to take next. Information messages suggest an action. 
Click Yes, No, or Cancel to continue. 
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Figure 3: Information message notification 

 

Note: From the Tools > Options Error Notification menu, you can set defaults for to-do 
messages just like the other message types. When the condition causing the to-do 
message has been met, it will be automatically deleted. 

Once the messages have been read, click OK to proceed with the additional steps.   

Note: If the steps are not completed, the warnings will appear in the task bar at the bottom of 
the screen.   

After fulfilling the conditions that originally generated the message, the message will be 
deleted, and it will no longer appear at the bottom of the screen.   

If the conditions are not met prior to converting the configuration to a quotation or prior to 
saving the configuration, the Gatekeeper window will appear as an additional 
reminder.  

Summary 

In this module, you have learned the following tasks: 
1. Understand how the Gatekeeper works. 
2. Recognize and respond to the following message notifications: 

 Error messages 
 To-Do messages 
 Warning messages 
 Informational messages 
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Rack Sequencing 

Module Objectives 

Upon completion of this module, you will be able to: 
1. Return configurations to the factory-default rack sequence 
2. Move components within a rack  
3. Capture and transmit custom racking information 
4. Work with custom racking messages 
5. Change custom configuration data 

Factory-Default Rack Sequencing 

 
Figure 1: Rack sequencing options 

The Configurator includes sequencing 
within racks according to factory-
specified defaults.  The rules are 
applied when Error Checking is 
turned on. 

Note: When Error Checking is 
turned off, the user can specify 
a sequence that does not match 
the factory-default rules, but the 
actual system built and 
delivered will be according to 
those rules. 

On the Tools > Options > 
Racking/Power tab, there are two 
user-selectable preferences using 
checkbox choices as shown in Figure 
1. 
• The first option is related to 

whether the user is to be warned if 
the racking sequence does not 
match the factory-default rules 

• The second option determines 
whether the factory default 
sequence should be applied after 
every configuration change. 
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In addition, there is a re-sequencing toolbar button  that is enabled only if the system diagram is 
displayed and has focus. When clicked, the Configurator will re-sequence the selected rack according 
to the factory-default rules. 

Alternative System-Diagram Mechanism (Move Components Within Rack) 

There are three toolbar icons  that are active when the system diagram is displayed and 
has focus.  The leftmost button causes the selected rack to be re-sequenced according to factory 
defaults.  The other icons are marked with stylized up and down arrows. If you highlight a storage 
enclosure case and click one of the toolbar buttons, the case will move to its new position.   

Note: If Forced Factory-Default Rack Sequencing is turned on, these three buttons will 
not be enabled. 

Capture & Transmit Custom Racking Information 

Custom configurations that do not have rack sequences in the factory-default order are flagged. 

Note: A custom rack sequence refers to the order of components within a rack, not the order of 
racks within a system. 

On the Tools > Global Options > Racking/Power tab, two user preferences can be set for rack 
sequencing: 

 Warned if a rack sequence deviates from factory-default rack sequence 
 Force factory default sequence 

When the second preference is set, configuration updates will be slower because of the extra 
processing required. 
 
If you wish to configure a custom rack sequence, click the first preference so the custom sequence will 
be highlighted, but do not click the not the second option, which would prevent such custom rack 
sequences. 

Note: When a non-factory-default sequence is present, a To Do message is created for each 
rack that is not in factory default sequence.   

Custom racking applies to the entire Whiteboard even if only one rack is out of default 
sequence.   

Custom configuration information is also noted on the Whiteboard item for the 
configuration. 

If only one configuration on the Whiteboard has custom configuration information, it 
applies to the entire whiteboard. 
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Custom Racking Messages 

Once the configuration is complete, if any custom racking messages have been generated, you have a 
decision to make: Do I really require custom racking or not?   

 If the answer is no, then go to the System Diagram, click on the rack flagged as being out 

of default sequence and click  to force the rack back into default sequence.  This 
action will remove the To Do message and re-sequence the rack according to factory 
defaults. 

 
 If the answer is yes, make sure the content of the rack are in the desired sequence by 

moving particular items up or down in the rack until the desired sequence is achieved.  
When you convert to quote or save, acknowledge the default-racking To-Do, and then the 
custom racking will be available to be sent to the shop floor when an order is created 
from this quote. 

Changing Custom Configuration Data 

Changes can be made to the custom configuration data for a quote or order at any time until the 
document status is complete.  Completed documents cannot be modified in the Configurator except to 
move an item up or down in a rack. 
 

Note: The status of the document will be Complete and the Whiteboard is disabled.  No other 
change is possible without performing a change order. 

Summary 

In this module, you have learned how to complete the following tasks: 
1. Return configurations to the factory-default rack sequence 
2. Move components within a rack 
3. Capture and transmit custom racking information 
4. Work with custom racking messages 
5. Change custom configuration data 
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Multi-SPU Configurations 

Module Objectives 

Upon completion of this module, you will be able to: 
3. Understand how to work with multi-SPU configurations and complete the following tasks: 

 Configure multi-SPU system 
 Name multi-SPU system 
 Add hardware or software 
 View multi-SPU connectivity on the Configuration Worksheet 
 View multi-SPU connectivity on the System Diagram 
 View the connections diagram 
 View the hardware list 
 Rack multi-SPU systems 
 Stack in Stacked-Node V class 
 Stack or unstuck in the Configuration Worksheet and System Diagram 
 Clone multi-SPU systems 
 Use multi-edit capability 
 Indent software under associated SPUs 
 Handle support in multi-SPU systems 

Configuring a Multi-SPU System 

Creating a Base System 

Step 1: From the main menu, click Insert > System, or click the Configuration Worksheet 
toolbar button to bring up the Configuration Selection Wizard. 

Step 2: Select a system for which multi-SPUs are supported, and then choose the desired rack 
type and power-protection choices. 

Step 3: Click Create. 

Adding another SPU  

Step 1: Once you’ve created a server base configuration, go the lower left windowpane of the 
Configuration Worksheet, and click the SPU tab to bring up a view of the SPU choices.  

Note: The SPU tab is the rightmost of the available tabs (from left-to-right being Enclosures, 
Software, Accessories, and SPU). This is not to be confused with the SPU button that 
appears as one of the buttons located below the parts tabs display.  You may have to use 
the arrows at the upper right-hand corner of the tabbed displays to scroll over to the SPU 
tab.  Choices are limited to “homogeneous systems,” namely systems in the same class. 
See Figure 1 below. 
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Figure 1: SPU tab 

Step 2: Click on the Server category “+” sign, to start browsing for the server you want to add or 
use the find function to look for the desire model. Once you find the model you want to 
add, click Add. The second SPU is added to the System Overview windowpane. 

 Some messages will pop-up advising you of actions to be taken, acknowledge the 
messages and proceed 

Step 3: Change the name of the system, if desired. The property sheet for the newly added SPU is 
located on the right-side of the Configuration Worksheet. 

Step 4: Switch to the System Diagram and note the two SPUs were added, in this case, each 
within a single rack. 

Step 5: You may add additional SPUs to the system in the same way, or you may add SPUs via 
cloning. 

Naming a Multi-SPU System 

Every time an SPU is added to a system, the user is given the opportunity to change the label 
describing the system.  A Rename-System dialog box appears with a suggested name (e.g., 3 
SPU's #2), highlighted for quick editing. 

Adding Hardware or Software 

To add hardware or software for a specific SPU in a multi-SPU system: 

Step 1: Click on the target SPU to highlight it as the target for the addition. 

Step 2: From the Parts tabs at the bottom left of the Configuration Worksheet, pick the tab 
containing what you want to add. For example, to add an ESL Extended Tape Library, 
click Enclosures, and navigate to Nearline Storage  StorageWorks Tape Libraries  
StorageWorks ESL9000 tape libraries and select ESL9322 Extended Tape Library. 

Step 3: Double click your selection, or highlight the selection and click Add. 

Result: The ESL9322 Extended Tape Library appears under the designated SPU in the system overview 
windowpane, and the ESL9322 Extended Tape Library property sheet is displayed on the right-hand 
side of the Configuration Worksheet.  With the latter, you can supply the drives, media/supplies and 
accessories. 
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Note: When selecting a target SPU for an addition (e.g., a storage enclosure), it is important to 
highlight the given SPU rather than the rack that contains it. 

In the case of software, there is user choice of whether software appears as a sub-tree 
under each SPU or appears under a software node and sub-tree under the overall system.  
This user choice is accomplished through setting a main menu Tools > Options > 
General preference. 

Multi-SPU Connectivity on the Configuration Worksheet 

In the Configuration Worksheet, the components associated with the specific SPU (including the SPU 
itself) have a small blue dot in the arrow that appears just to the left of the label for each such 
component.  These dots appear whether one clicks on the specific SPU or one of the other components 
associated with it as shown in Figure 2 below. 

 
Figure 2: Blue dots denote association with specific SPUs 

Note:  A UPS will not have such a dot since a UPS is not necessarily “captive” of a single SPU 
and its directly associated components. 

Multi-SPU Connectivity on the System Diagram 

Left-clicking on an SPU will cause that SPU and its external storage enclosures or drives to be 
highlighted in blue.  What gets highlighted within a storage enclosure depends on the type of storage 
system.  For example, in the case of a High Availability Model 20 Disk Array, any storage processor is 
highlighted, representing the whole subsystem.  In the case of a High Availability Storage System, the 
disk drives are highlighted, representing the whole subsystem as shown in Figure 3 below. 
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Figure 3: Disk drives are highlighted representing whole subsystem 

 
Left-clicking on a UPS causes that UPS and any of the units (e.g., SPU and/or external storage) it is 
powering to be highlighted.  On the monitor screen, the highlighted areas are blue. 
 

Note: If an external storage unit is being powered by a given UPS, and you left click on that 
UPS, the whole external storage and its enclosure will be highlighted in blue.   

If you click on an UPS that is powering an SPU, and that SPU has an associated external 
storage subsystem, the UPS and SPU will be “fully highlighted.”  Only the associated 
attached storage processor(s) or connected disk drives and not the enclosure itself (or 
enclosure-related items such as power supplies or fans) will be highlighted in blue.  A 
storage processor in this case is highlighted because it is connected to the SPU rather 
than it being powered by the given UPS. 

What can go here? & What can replace this? function in the same way as for 
single-SPU systems. 

Connections Diagrams in Multi-SPU Systems 

The connections appear just as they would for a single-SPU system, but now there are two or more 
SPUs and associated connections displayed.  There is currently no modeling of interconnections among 
the multiple SPUs in a Multi-SPU System. 

Hardware List in Multi-SPU Systems 

The hardware list appears as always in that total quantities of components are given rather than 
quantities broken down structurally by SPU.  Thus there is no connectivity information obtainable from 
the hardware list view. 
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Racking in Multi-SPU Systems 

Multi-SPU systems have a line-item formatting rule mandated by manufacturing requirements, which 
says that the product number for the rack must be listed in the line items before the product numbers of 
the items in the rack, including the SPU. 

Stacking in Stacked-Node V Class 

V-Class SPUs can be physically stacked on one another to make more efficient use of space in the 
appropriate situations.  If you are going to stack SPUs (only in pairs) in a Stacked-Node V-Class 
System, the SPUs to be stacked must be the same model, so a V2200 Enterprise Server cannot be 
stacked with a V2250 Enterprise Server, even though both SPUs are V-Class Enterprise Servers.   
 
Usually different models within a product line will be differentiated by CPU speed, but in the case of the 
two versions of the V2500 Enterprise Server, both have 440 MHz CPUs, but one has the SCA memory.  
These two versions of the V2500 are different and cannot be stacked with each other. 
 
Stacking can be accomplished by (a) setting the stacking options for the SPUs to be paired on the CPU 
tab of the Configuration Worksheet for each of the SPUs in the pair, or by (b) dragging and dropping 
one SPU on the other in the System Diagram.  In the case of the latter, the rectangular outline displayed 
during the stacking process will “snap” into place when one is close to the correct alignment as shown 
in Figure 4 below. 
 

 
Figure 4: Stacking SPUs using the System Diagram 

 
Result: When stacking is successful, the SPUs in the Configuration Worksheet view (CPU tab) will 
have the stacking status shown properly with each pair having one SPU designated as Bottom 
Stacking and its companion SPU designated as Top Stacking as shown in Figure 5 below.  In the 
System Diagram view, the same physical orientation of the units should hold. 
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Figure 5: Top & Bottom Stacking 

Note: Although you can move components around on the System Diagram and can make any 
two SPUs appear to be stacked, this will only be a “false: impression for SPUs that cannot 
be stacked. If you try to save and restore configurations with “false” stacking, the 
components will not be stacked.   

An alternative check, from the main menu, click View >Reset Diagram Layout. The 
configuration with “false” stacking will be redrawn with the components no longer 
stacked. 

Stacking or Un-stacking Using Worksheet Options 

The CPU tab of each VClass SPU contains a stacking option selection.  An SPU can be configured as 
“top stacking”, “bottom stacking”, or “none” as shown in Figure 5 above.  Stacking an SPU means that 
one SPU is physically placed on top of another SPU. 
 
In a single SPU configuration, the user will not see a visible change in the system diagram after 
selecting a stacking option because there are no other SPUs to interact with.  In a multi-SPU 
configuration, the SPU will automatically move into position above or below another available SPU on 
the system diagram.  Only two chassis may be in a stacked configuration. 
 
Un-stacking two SPUs can be performed by simply selecting None.  In the event that there is a third 
SPU with an existing stacking option prior to the un-stacking operation, the third SPU will automatically 
select one of the newly un-stacked SPU and establish a stacked relationship with it.  An SPU with a 
stacking option will always attempt to obey its directive to stack. 
 
When a new SPU is brought in, its stacking option will automatically be initially set to appropriately 
stack with an not-yet-matched SPU, if one exists, that is set to Bottom Stacking or Top Stacking but 
does not (yet) have a mate. 

Stacking or Un-stacking Using System Diagram 

If two or more SPU have been configured and are currently in an un-stacked relationship, the system 
diagram can be used to specify exactly which two SPU should be brought together and in what manner 
they should be stacked. To perform the stacking operation, simply drag and drop an SPU’s chassis into 
the region above another SPU’s chassis.  The two SPU will automatically lock together and the 
appropriate worksheet stacking options will be set. 
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To un-stack two SPUs, simply drag and drop one chassis from the stacked pair into a region of the 
diagram away from its counterpart. 

Cloning in Multi-SPU Systems 

Cloning allows multiple copies of a component (e.g., SPU, storage enclosure, disk drive, etc.) to be 
replicated and inserted.  Both copying and pasting are combined into one step and more than one 
such operation can be done at one time.   
 
The Cloning Limit, namely the number of components that can be cloned at one time (say 10) can be 
set by user preference from the main menu by navigating to Tools > Options > General tab, and 
this limit can be overridden.  Whole systems can be copied but not cloned.  
 

Note: Cloning can be time consuming. 

 
SPUs in a multi-SPU system, as well as other components such as storage enclosures, can be cloned.  If 
you clone an SPU, the software associated with the SPU gets cloned, but the storage enclosure 
associated with the SPU does not.  With the future capability of dealing with shared storage, cloning 
external storage may well not be applicable.   
 
Right-click the component to be cloned in either the System Overview windowpane of the Configuration 
Worksheet or on the component in the System Diagram, and then click Clone.   

Note: If you clone a storage enclosure with disk devices in it, the disk devices are cloned as 
well. 

Editing Across Multiple-SPU Systems 

It is easy to apply a change across multiple SPUs in a system.   

Note: The multi-edit capability is only applicable to identical SPU models (e.g., same processor 
speed).  

For example, say you wish to have four processors in each of two SPUs in a two-SPU system.  Left-click 
on the first processor to highlight it. Then, hold down the [Control] on your keyboard and left-click on 
the second processor.   

Note: The arrows to the left of the label caption for each of the SPUs will be a dark blue color, 
but only the second SPU selected will have its label caption highlighted as shown in 
Figure 6 below. 
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Figure 6: Multi-edit capability for identical SPUs 

From the CPU tab, click 4 as the number of processors (the number of processors is displayed in a red 
color indicating an unapplied changed), and then click Apply.   

Note:  Selecting either of the SPUs in the System Overview windowpane shows a CPU property 
sheet indicating the presence of four processors. Similarly, four processors per SPU will 
appear on the System Diagram and there will be a quantity of eight processors shown in 
the hardware list. 

Indenting Software Under an Associated SPU 

There are alternative ways to display software in the System Overview view.  
1. One way is to have a software sub-tree under the system node in which all of the software for 

the system appears regardless of SPU, although the sub-tree is organized by SPU.   
2. The other way is to have the software for each SPU appear under that given SPU in a sub-tree 

whose head node is labeled Software as shown in Figure 7 below. 

 
Figure 7: Software nodes under each SPU 

 
Which alternative to use is a personal choice.  If there are a number of software packages included, 
having them all appear under a software node attached to the overall system can make viewing of SPU-
associated storage enclosures/subsystems easier. 
 
To select your preferred display, click Tools > Options > General and locate the Indent S/W to 
SPU in Worksheet checkbox in the lower right-hand corner of the property page.   

Support Options in Multi-SPU Systems 

Items associated with a given SPU within a system will be assigned the same support options as the 
parent SPU.  Note that each SPU in a multi-SPU system can have a different set of support options. 
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Summary 

In this module, you have learned the following tasks: 
1. Understand how to work with multi-SPU configurations and complete the following: 

 Configure multi-SPU system 
 Name multi-SPU system 
 Add hardware or software 
 View multi-SPU connectivity on the Configuration Worksheet 
 View multi-SPU connectivity on the System Diagram 
 View the connections diagram 
 View the hardware list 
 Rack multi-SPU systems 
 Stack in Stacked-Node V class 
 Stack or unstuck in the Configuration Worksheet and System Diagram 
 Clone multi-SPU systems 
 Use multi-edit capability 
 Indent software under associated SPUs 
 Handle support in multi-SPU systems 
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Restoring the Whiteboard 

Module Objectives 

Upon completion of this module, you will be able to: 
• Understand how to restore a whiteboard 

Restoring the Whiteboard 

This functionality helps users open Whiteboards when one or more systems fail to restore. 
 
When a Whiteboard is opened and if for any reason, one or more systems in it cannot restore, they 
are represented in a different way indicating there is a problem. 
 

1. A warning message appears showing how many systems failed to restore as shown in Figure 1. 

 
Figure 1: Warning message 

2. The system that could not be restoring cannot be viewed on a System diagram, Connections 
diagram, Hardware list or a ConfigWorksheet.  

3. Using the right mouse click menu ‘Restore System’ option can be used to try and restore the 
system (i.e., if the problem due to which it failed to restore has been fixed).  

4. System properties can be viewed and Cut/Copy/Paste operations can be done on this hung 
system. 

5. LineItems and Convert to quote can also be done on this system to view the line items only if it 
was previously saved after converting to Quote. 

6. Parts from the parts list cannot be added to the hung system. 
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Figure 2: Available and unavailable functions with a hung system 

Summary 

In this module, you have learned the following tasks: 
 How to restore a whiteboard 



Sales Builder for Windows 12.0 Page 26 of 53 June 2005 

 

Working with Upgrades 

Module Objectives 

Upon completion of this module, you will be able to: 
 Use the upgrade wizard to upgrade an unspecified and specified system. 

Using the Upgrade Wizard 

Upgrading an Unspecified System 

Step 1: Ensure that nothing on the Whiteboard is highlighted; then from the main menu toolbar, 

click the Upgrade Wizard button , or click Insert  Upgrade. 

Step 2: Click Start with a minimally configured system from the list below, and then 
navigate to the system you want to upgrade. 

Step 3: Click Start Upgrade Wizard, and follow the wizard instructions. After entering the 
necessary information in each window, click Next to progress through the wizard. 

Step 4: From the Return To Whiteboard window, select or clear the checkbox to add add-ons 
to upgrade. 

 When the checkbox is selected, click Finish to place the upgrade on the Whiteboard 
and display the System Diagram view of the upgrade, plus the Parts List for the addition 
of further add-ons. 

 When the checkbox is not selected, click Finish to place the upgrade on the 
Whiteboard. 

Note: To display the Upgrade View of an upgraded system on the Whiteboard, right-click the 
system, click View from the shortcut menu, and then click Upgrade from the submenu. 

Upgrading an Existing System on the Whiteboard 

Step 1: Select the system on the Whiteboard you want to upgrade; then from the main menu 

toolbar, click the Upgrade Wizard button . The system appears in the Upgrade 
Wizard window. 

Note: You can also right-click on the desired system and click Upgrade System, OR select 
the system on the Whiteboard, and then click Insert  Upgrade. 

Step 2: Follow the wizard instructions to build the upgrade. After entering the necessary 
information in each window, click Next to progress through the wizard. 

Step 3: In the Mark current system not to be quoted checkbox, clear or select the option. 
If selected, only the upgraded system is used when you convert to a quote. 
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Step 4: From the Return To Whiteboard window, select or clear the checkbox to add add-ons 
to upgrade. 

 When the checkbox is selected, click Finish to place the upgrade on the Whiteboard 
and display the System Diagram view of the upgrade, plus the Parts List for the addition 
of further add-ons. 

 When the checkbox is not selected, click Finish to place the upgrade on the 
Whiteboard. 

Note: To display the Upgrade View of an upgraded system on the Whiteboard, right-click the 
system, click View from the shortcut menu, and then click Upgrade from the submenu. 

Summary 

In this module, you have learned the following task: 
 Use the upgrade wizard to upgrade an unspecified and specified system. 
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SPU Replacements 

Module Objectives 

Upon completion of this module, you will be able to: 
4. Understand SPU replacement and the following associated topics: 

 Replacing SPUs 
 Initiating SPU replacement 
 Racking & power-protection preference prompts 
 SPU replacement report 
 SPU replacement rules 
 Overriding power protection for external devices 
 Qualifying UPS or rack 
 Overriding UPSs or racks in the starting configuration 
 Quoted components in SPU replacement 

Replacing an SPU 

SPU replacement is the ability to switch SPU models at any point in the configuration process and have 
as much as is reasonable of the configuration (e.g., added disk storage) mapped over to the newly 
selected model.  Configurator users are frequently asked to prepare quotations for roughly the same 
configuration based on a variety of SPU models; this is the scenario where SPU replacement has most 
to offer. 
 
Other parameters can be changed by applying the SPU replacement function as well, such as racking 
and power-protection choices.  Used in this way, the SPU itself may or may not be replaced. 
 
SPU Replacement works both within class (e.g., K460 > K570) as well as between classes (e.g. D380 
> K360). 

Note: SPU replacement cannot be performed on Multi-SPU Systems. 

Initiating SPU Replacement  
The three alternatives to initiate SPU replacement are: 

 SPU command button on the bottom left of the worksheet 
 Change SPU item on Edit menu that is enabled whenever a specific configuration is 

active 
 Change SPU item on pop-up menu obtained by right-clicking on a system icon on a 

Whiteboard 
 
Any of the above options cause the Configuration Selection Wizard to appear, where you can then 
make any changes desired to any of the inputs on the form. To proceed with the changes, click 
Update. 
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Racking & Power-Protection Preference Prompts 
Depending on what changes were requested in racking and power protection preferences, and on the 
starting configuration, you may be prompted as to whether the new racking and power protection 
preferences should be applied retroactively across the entire starting configuration or just be applied to 
subsequently added components.  These allow the user to copy over a mixed UPS or rack configuration 
and attempt to retain the current mix. 

SPU Replacement Report 
When you request a different SPU, a report is displayed showing, in summary form, the effect of the 
replacement; the report compares the “before” and “after” system.  At this point, you have the option to 
(a) cancel, (b) proceed with the replacement, or (c) proceed but make a back-up copy of the starting 
configuration.  This report is not displayed if the SPU is not changed, but only other preferences.  
 

 If you click Cancel, the configuration remains unchanged. 
 If you click OK, the replacement takes effect; the starting configuration is replaced by the 

new configuration. If the Configuration Worksheet (or other view) is visible, it is updated 
to reflect the new configuration.   

 If you click Copy, the same thing happens except that an additional object is added to 
the Whiteboard.  This additional system is identical to the starting configuration. 

SPU Replacement Rules 
The operation starts with a “base configuration” for the target SPU model according to the newly 
selected preferences.  The term “base configuration” is used to refer to the configuration produced as a 
result of the user selections in the Model Selection Form when the configuration was originally 
generated.   

Note: Unless you change the selection, or the starting operating-system version is not 
compatible with the target SPU model, the operating-system version will be copied from 
the base to the target system at this stage. 

 When you select a different SPU model, the initial values behave in a “sticky” manner: 
i.e., if a particular setting is consistent with the newly selected model, it is retained.  It is 
only changed if the value is inconsistent with the new model. 

 A power check on UPS capacity is made to ensure that the needs of the target 
configuration can be met. 

 Changes are made to the target configuration corresponding to changes that had been 
made between the base starting configuration and the starting configuration at the point 
that the SPU replacement operation was invoked. 

 Only components that were explicitly added to the starting configuration are considered 
for copying.  “Explicitly added” means that you directly requested the components via 
addition or replacement operations from the Configuration Worksheet, System Diagram, 
Hardware List, or Whiteboard drag and drop.   
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Note: Components not explicitly added to the starting configuration must have been added by 
the Configurator in response to another request; if corresponding components are not 
required to meet requests in the new configuration, there is no reason to add them.  
Components that were in the base starting configuration but not in the base target 
configuration will not be copied over, since you did not request these components 
explicitly. 

 To copy a component, the Configurator checks whether it exists in the target product line.  
If it does, an attempt is made to copy it; if it does not, an attempt is made to find a 
functionally equivalent component in the target product line (currently this functional 
equivalence only covers RAM and disk).  If one is found, the component is requested in 
the target configuration. 

Note: If a request fails (for whatever reason), the SPU-Replacement algorithm continues on to the 
next component.  The process does not stop at the point a request cannot be met. 

 External enclosures (e.g. disk arrays) are copied so as to preserve (a) their internal 
configuration (b) their position in a rack, if any, and (c) their state of power protection, 
where possible.  Please see following sections for details on the handling of racks and 
UPSs. 

 As soon as the memory quantity in the start system is equaled or exceeded by the target 
system (once the base target system has been created), memory copying stops. 

Overriding Power Protection For External Devices 
If there are external devices in the starting configuration whose power protection state (on or off) is 
different from that selected in the Model-Selection Form, you are given the option of: 
 

1. Applying the new preference across the starting configuration (i.e., turn the power protection 
state for all external devices either on or off depending on the selection), OR  

2. Leaving the external devices in their current state of power protection.  
 
You can click Yes or No, or you can Cancel the process. 

Qualifying UPS or Rack 
Depending on the situation, a dialog box may pop up relating to overriding UPSs or racks in the 
starting configuration noting that a preferred selection differs from the one appearing in that starting 
configuration. 
 
Rather than the user needing to respond in situations where the result would be the same irrespective of 
your answer, the dialog box only appears if the component(s) in question are qualifying.  For example, 
the rack housing a given SPU cannot be overridden, but a non-SPU-containing rack housing external 
storage can. 
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Overriding UPSs in Starting Configuration 
If the selected preferred UPS in the SPU Replacement is different from one or more qualifying (see 
explanation below) UPSs in the starting configuration, you are given the option of replacing the 
qualifying UPSs with the preferred one, or of preserving the existing UPSs (where appropriate).  
Alternatively, you can cancel the process.   

Note: The number of UPSs can change based on power required and power offered.  For 
example, instead of a one-for-one replacement of each of two 1.8 kVa UPSs in a starting 
configuration, it may be that a single 3.0 kVa unit is more appropriate in a given context. 

Qualifying SPU UPS Criteria 
 If the SPU’s UPS in the starting system is not a valid UPS for the SPU in the target system 

and you have selected to power protect the SPU in the target system, the SPU’s UPS in the 
starting system does not qualify. 

 If the SPU’s UPS only supports the SPU, and you have selected not to power protect the 
SPU in the target system, the SPU’s UPS in the starting system does not qualify. 

 If the chosen preferred UPS is not a valid UPS for the SPU in the target system and you 
have selected to power protect the SPU in the target system, the SPU’s UPS in the starting 
system does not qualify. 

 Any UPS in the starting system that is not in the target system’s product line does not 
qualify. 

 All UPSs in the starting system not disqualified by the above qualify. 

Overriding Racks in Starting Configuration 
If the selected preferred rack in the SPU-change form is different from one or more qualifying (see 
explanation below) racks in the starting configuration, you are given the option of (a) replacing the 
qualifying racks with the preferred one, or (b) preserving the existing racks (where appropriate).   

Note: Based on rack sizes, the number of racks may change. 

Qualifying Racks Criteria 
 If the SPU’s rack in the target system will be forced, the SPU’s rack in the starting system 

(if any) does not qualify. 
 If the SPU’s rack contains only the SPU and UPS’s, and you have selected not to rack the 

target SPU, the SPU’s rack in the starting system does not qualify. 
 If there is an expansion rack in the starting system, it does not qualify. 
 Any rack in the starting system that is not in the target system’s product line does not 

qualify. 
 All racks in the starting system not disqualified by the above qualify. 

 
A non-base rack in the configuration is one that was added by the user after the base configuration 
was generated.  If there are one or more non-base racks in the configuration, which are different from 
the selected preferred rack, you are given the option of (a) replacing them with the preferred rack, or 
(b) attempting to copy over the existing racks. 
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Quoted Components in SPU Replacement 
SPU replacement currently treats all components in the starting configuration as quoted, even if some 
are not.  That is, when it copies the components into the target configuration, it copies them all as 
quoted.  If there are unquoted components in the starting configuration, a warning message is 
displayed in the SPU replacement report. 

Summary 

In this module, you have learned the following tasks: 
1. How to work with SPU replacement and the following associated topics: 

 Replacing SPUs 
 Initiating SPU replacement 
 Racking & power-protection preference prompts 
 SPU replacement report 
 SPU replacement rules 
 Overriding power protection for external devices 
 Qualifying UPS or rack 
 Overriding UPSs or racks in the starting configuration 
 Quoted components in SPU replacement 
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Long-Running Engine Operations 

Module Objectives 

Upon completion of this module, you will be able to: 
5. Cancel long-running engine operations 
6. Understand how cancellation can cause incomplete configurations 

Canceling Long-Running Engine Operations 

Previously various kinds of configuration updates have been liable to “hang,” forcing the user to restart 
the Configurator application and lose work.  Specifically, the situations included opening a saved 
configuration, worksheet applies, preference changes, and right-mouse clicks in the System Diagram.  
This was due to long-running (perhaps even infinitely long running) Knowledge-Base-Engine operations.   
 
Now, the user can specify a time interval for the number of seconds between Knowledge-Base interrupts 
using Tools > Global Options > General (lower left-hand corner). 
 
For any configuration update operation that has not completed within the specified time interval, a pop-
up dialog appears giving the user the choice to continue (for another period of time) or cancel.  If the 
user selects cancel, the Configurator behaves as if the update failed, returning the state to that 
immediately prior to the update.  In all cases other than opening a configuration, this means that the 
user can recover their configuration and can continue to work without having to kill the Configurator 
and start it again. 
 
In the case of opening a configuration, all or some of the configuration still cannot be opened—the 
benefit is that other configurations on the same Whiteboard can be opened, and the user need not 
restart the application.  A large configuration, however, can take a long time and one might continue 
for quite some time to answer message boxes asking whether you want to continue configuration and 
still be in a normal situation with the Whiteboard eventually opening successfully. 
 
Note that the time interval selected has to do with configuration steps where the configuration of a 
complete single base system is such a step.  Say you have set the interval for the KB-interrupt time 
interrupt set to 10 seconds and are restoring a Whiteboard with five individual systems on it.  This 
means that each of the five systems could take up to slightly less than 10 seconds to configure and one 
will never have the cancellation choice dialog box displayed.   
 
The situation is a bit more complicated in that in configuring a complete system one goes through three 
steps: 

 Initial System Configuration 
 Bundling System Components (if error checking on) 
 Finish Configuration 
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In fact, each of these steps could take up to slightly less than 10 seconds before the cancellation choice 
dialog box was displayed. 

Cancellations Generating Incomplete Configurations 

It is important to note that you may choose to cancel a long-running engine query at a point where an 
incomplete configuration will result.   
 
Configuration involves multiple phases.  There are two major components to configuring a system:   

1. Configuration 
2. Bundling (namely the assignment of Product Numbers) done by the Bundler 

 
Bundling is only done during the time that one is configuring a system on the Whiteboard if error 
checking is on (the Full Checking checkbox is checked on the System-Detail Form).  Otherwise 
Bundling will occur only when doing View->Product Numbers or converting the configuration to a 
quote.   

Note: The ability to cancel a long-running engine operation applies only to the configuration 
process, not bundling.  In practice, however, the bundling process will rarely hang. 

In some cases, when you cancel a long-running operation, it may appear that the configuration is 
complete because you see what at least appears to be a complete configuration on the System 
Diagram or in the System Overview windowpane of the Configuration Worksheet.  However, a line 
item as seen in the viewer for line items may be absent or incorrect.   
 
Assume that the last system is suspect if you see any of the following messages displayed: 

 Finish Configuration Event Failed 
 Generate Warning Event Failure 
 Pre-bundling Event Failed 

 
The safest thing to do is to delete it rather than take a chance. 

Summary 

In this module, you have learned the following tasks: 
1. How to cancel long-running engine operations 
2. How cancellations can cause incomplete configurations 
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Saving & Restoring Configurations 

Module Objectives 

Upon completion of this module, you will be able to: 
7. Save and restore Whiteboards as WWB files 
8. Understand why restoring complex systems can be time-consuming 

Saving & Restoring Whiteboards as WWB Files 

A Whiteboard can be saved as a file with “.wwb” as its extension on the local disk drive. 
 
The two related menu items on the main menu> File menu are Open from WWB File and Save 
As WWB File.  When a WWB file is opened, it is loaded into a new Whiteboard. 

Why Restoring Complex Systems Is Time-Consuming 

As systems get increasingly complex, the time to restore saved systems will increase.  This is particularly 
true with multi-SPU systems where through the SPU Tab or via cloning, a number of SPUs can be 
added. 
 
The time required to restore such saved systems can be significant because of all the relationships in 
which an SPU is involved.  Thus it may appear that the Configurator has hung rather than it just needs 
a longer time to complete restoration. 

Summary 

In this module, you have learned the following tasks: 
1. How to save and restore Whiteboards as WWB files 
2. Why restoring complex systems can be time-consuming 
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Cloning Configurations 

Module Objectives 

Upon completion of this module, you will be able to: 
9. Clone components in your configuration 
10. Clone multi-SPU systems 
11. Clone SCA system cabinets 
12. Understand what happens if there isn’t enough space to clone 

Cloning Components 

Cloning can be performed in the Configurator Worksheet System Overview windowpane, System 
Diagram, and Hardware List view. 
 
Cloning combines the copy and paste functions into one step. The original object and the cloned object 
are placed in the same port or bay (space permitting). 
 
To clone an object, right-click on the object, and then click Clone. In the Clone dialog box, type a 
value to determine the number of clones to be inserted. 

Cloning Multi-SPU Systems 

Cloning allows multiple copies of a component (e.g., SPU, storage enclosure, disk drive, etc.) to be 
replicated and inserted.  Both copying and pasting are combined into one step and more than one 
such operation can be done at one time.  The Cloning Limit, namely the number of components that 
can be cloned at one time (say 10) can be set by user preference (Main-Menu Tools Options  
General tab), but can be overridden. Whole systems can be copied but not cloned.  

Note: Cloning can be time consuming. 

SPUs in a multi-SPU system, as well as other components such as storage enclosures can be cloned.  If 
you clone an SPU, the software associated with the SPU gets cloned, but the storage enclosure 
associated with the SPU does not.  With the future capability of dealing with shared storage, cloning 
external storage may well not be applicable. 
 
Right-click on the component you want to clone in either the System Overview windowpane of the 
Configuration Worksheet or on the component in the System Diagram.  If you clone a storage enclosure 
with disk devices in it, the disk devices are cloned as well. 

Cloning SCA System Cabinets 

Cloning a Primary SCA Cabinet results in a non-SCA Cabinet.  Clones of a Secondary SCA Cabinet 
result in Secondary Cabinets that join the same complex if positions are available.  Any clone of a 
Secondary Cabinet for which there is not a position in the complex will become a non-SCA Cabinet.  
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For clones of either a Primary or Secondary Cabinet/System, the software associated with that cabinet 
is cloned as well. 
 
When a clone of a Secondary System becomes a stand-alone non-SCA System, it will inherit all of the 
same Operating-System options as the Primary System and inherit the same software as the Clone 
Template.  The Clone Template’s software may have been transplanted onto the Primary System but will 
still be cloned. 
 
When the Clone of a Secondary System becomes a Secondary System and joins the same group as the 
Clone Template, it sheds its software to avoid conflict with its Clone Template. 

Lack of Space 

If at least one component cannot be cloned due to lack of space, the Configurator sends you a 
message notification. 

Summary 

In this module, you have learned the following tasks: 
1. How to clone components in your configuration 
2. How to clone multi-SPU systems 
3. How to clone SCA system cabinets 
4. What happens if there isn’t enough space to clone 
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Adding Parts through the Parts List (Add-Ons) 

Module Objectives 

Upon completion of this module, you will be able to: 
1. Understand the following topics associated with Add-Ons and the Parts List: 

 Add-Ons functionality set 
 Quote indicators 
 Activating the Parts List 
 Contents of the Parts List 
 Filtering the Parts List 
 Product numbers on the Parts List 
 Dragging components from the parts list to existing systems and to the Whiteboard 
 Model Selection Form in Add-Ons 
 Configuration Worksheet in Add-Ons 
 System Diagram in Add-Ons 
 Hardware List in Add-Ons 
 Whiteboard icons in Add-Ons 
 Product number viewer for Add-Ons 

Add-Ons Functionality Set 

Rather than being a single piece of functionality, Add-Ons involves the application of several different 
pieces of standard Configurator functionality to add components to an existing configuration.   
 
Add-Ons functionality begins in the Parts List.  Components selected in the Parts List can be added to an 
existing system or for upgrades through dragging and dropping them onto (a) a system icon on a 
Whiteboard, or (b) a System-Detail Form (to a System Diagram or a Hardware List).  Add-Ons involve 
the Model Selection Form if a component is not being added to an existing system. 

Quote Indicators 

Which items are to be quoted are indicated in detail in two views on the System Detail Form.  On the 
Configuration Worksheet, optional icons called Quote Indicators can be toggled on and off through 

the Quote Indicator toolbar button . 
 
On the System Diagram, components not to be quoted appear in white rather than gray. 

Activating the Parts List 

From the Whiteboard, click the Add-On (Parts List) icon  to bring up the Parts List.   
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Alternatively, you can load the Parts List by either selecting View-> Add-On (Parts List) from the main 
menu.  The Parts List is the launching point for Add-Ons.   

Part List Contents 
Two types of components appear in the Parts List: 

 Simple components: Products that can be ordered by themselves and do not require 
any further specification in the worksheet.  Most simple components will have a part 
number in parentheses after the Parts-List description. 

 Configurable Components: Products for which additional configuration is offered 
using the Configuration Worksheet.  Examples are software, ASCII terminals, printers, 
and storage enclosures.  For ease of use, ASCII terminals and storage enclosures may 
have a product number in parentheses after the description.  Even where they have 
product numbers, unlike the case of simple components, the choice of “Unspecified (No 
configuration support),” as described later, is not offered on the displayed Model-
Selection Form. For some ASCII terminals, the last character of the product number is not 
displayed as it represents the color choice of the terminal, and this is chosen on the 
Configuration Worksheet. 

Filtering Parts List 
Filtering by product line can narrow the list of candidate products appearing in the Parts List. This can 
be accomplished by clicking Show Filter.  Select the filtering criteria you want to use, and the Parts 
List adjusts accordingly.   

Product Numbers on Parts List 

The product numbers presented in the Parts List are the “field” versions.  If the Add-On is a “pure” Add-
On (meaning the underlying system or rack is not to be quoted), the product number in the quotation 
will be the same as that in the Parts List.   
 
Exception: The exception to this applies to those ASCII terminals that will have a last character added 
reflecting the choice of color. If the Add-On is in the context where the underlying system or rack is to 
be quoted, the product number may change since the “factory-integrated” version cannot be 
determined until actual configuration takes place.  Thus the product number appearing in a quotation 
may be different from what is displayed in the Parts List. 

Dragging Components to an Existing System 

This mechanism is useful for adding products to an existing system and for upgrades.  A confirmation 
message is displayed stating that the components were successfully added to the system. 
 
A component can be added by dragging it from the Parts List to a target system represented by one of 
(a) a system icon on the Whiteboard, (b) the System Diagram on the System-Detail Form, or (c) the 
Hardware List on the System Detail Form.   
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In the latter two cases, you can see directly whether the component has been added or not, so the 
message indicating that the requested component(s) have been added is not displayed. In the case of 
the Hardware List, the drop action need not be to the region of the list where the newly added 
component will be listed. 

Dragging Components to the Whiteboard 

When you drag a component and drop it on the Whiteboard canvas, a Model-Selection Form is 
displayed. Available selections have been filtered by the operating system and product line of the 
selected component.  
 
For potential use in conjunction with components with a visible part number, a choice of “Unspecified 
(No configuration support)” is provided. 
Selecting a system creates a default base reference system and marks it “Do not Quote.” If additional 
products are required to support the Add-On component, a dialog box is displayed asking you whether 
or not you want to quote any or all of the additional products that were automatically inserted.   
 
A Configuration Worksheet appears to configure additions or make further changes. The Quote-

Indicator button  will be automatically selected on the System Detail Form tool bar, so Quote-
Indicator icons will be displayed to mark the items that will appear in a quotation. 
 
Dropping components on the Whiteboard limits the list of systems in the Model Selection Form to those 
with the same product line as the component as well as filtered with the same operating system as the 
component. 

Model Selection Form in Add-Ons 

The Model Selection Form is the same as that used when configuring a new system, except a new field 
for tier is displayed as shown in the upper right corner of the form. Systems available for selection are 
narrowed to the product line selected on the Parts List, the product line(s) of the selected product, and 
the operating system of the selected product. The range of choices in a given case is the same as for 
configuring a new system. Choices made here are reflected in the Configuration Worksheet. 
 
“Simple” products or products that do not require any additional configuration, such as disks, memory, 
cables, etc., should have a product number in parentheses after their Parts List description. When this is 
the case, an additional choice of Unspecified (No configuration support) appears as in the 
Model Selection Form.  This item is highlighted since it selected as the default.  Thus it is not necessary 
to configure a system to request such a product (although you can).   
 
Software, storage enclosures, ASCII terminals, printers, and networking cards that require additional 
software are examples of products that will not have Unspecified (No configuration support) 
available as a selection since (although they may still have a product number in parentheses following 
the description) they must be configured within a context. 
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Configuration Worksheet in Add-Ons 

The significant difference in the Configuration Worksheet from configuring a new system is that Quote-

Indicators icons  are enabled and displayed just to the left of components that will be quoted.  
Quote Indicators also appear in the System Overview Pane in the upper left portion of the worksheet as 
shown in Figure 1 below. Quote Indicators for individual components have blue backgrounds, not 
yellow. 

 
Figure 1: Quote Indicators in the System Overview windowpane 

 
On the right-side of the worksheet, the Quote Indicators appear as (a) the yellow-background dollar 

sign if all or some of the components for that element are to be quoted or (b) as a caret  when none 
are quoted.   
 
As shown in Figure 2 below, left-mouse clicking on the Quote Indicator icon pulls down a list to allow 
specifying the number of components to quote.  If you configured a system with 3 memory boards, 
clicking on the icon displays a pop-up with Quote 0 … Quote 3 and a check next to the number 
currently quoted, in this case two. 

 
Figure 2: Quote Indicator showing 2 quotes 

      

Note: The components actually quoted are listed in the System Overview Pane.  For example, 
where there are three processors included in the system, but only two are to be quoted, 
only two are listed in the System Overview Pane. 
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Once you are using the worksheet in connection with the first Add-On, you can continue to make 
further additions as desired that apply to the selected system. 
 
In the Add-On mode, there is a dialog box displayed listing supporting components not specifically 
requested that are brought into the configuration (e.g., additional memory may require another memory 
carrier).  You can then select any or all to be quoted. 

System Diagram in Add-Ons 

Colors are used in the System Diagram to distinguish between quoted and not- quoted products.  Non-
quoted products are white; quoted products are gray. 
 
You can drag and drop components from the Parts List to the System Diagram.  Since you can see 
additions being made to the System Diagram, there is no confirmation message that components have 
been added to the configuration. 

Hardware List in Add-Ons 

As with the System Diagram, you can drag and drop components from the Parts List to the Hardware 
List.  Since you can see additions being made, there is no confirmation message that components have 
been added to the configuration.  The drop action need not be to the region of the list where the newly 
added component will be listed. 

Whiteboard Icons in Add-Ons 

The Whiteboard icons have a different appearance depending on whether or not a system was 
configured. If a system was configured, then underneath the System Icon is an “Add-On” label with an 

associated icon, including a plus sign to its left as show: . 

Product-Number Viewer for Add-Ons 

The display of the Line Item Viewer is invoked from the main menu by navigating to View-
>Product Numbers. It works the same as when configuring new systems. Where the 
Add-On is a “pure” Add-On (meaning the underlying system or rack is not to be quoted), 
only Add-On product numbers will be quoted. 

Summary 

In this module, you have learned about the following topics: 
1. Add-Ons functionality set 
2. Quote indicators 
3. Activating the Parts List 
4. Contents of the Parts List 
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5. Filtering the Parts List 
6. Product numbers on the Parts List 
7. Dragging components from the parts list to existing systems and to the Whiteboard 
8. Model Selection Form in Add-Ons 
9. Configuration Worksheet in Add-Ons 
10. System Diagram in Add-Ons 
11. Hardware List in Add-Ons 
12. Whiteboard icons in Add-Ons 
13. Product number viewer for Add-Ons 
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Undo & Redo Functions 

Module Objectives 

Upon completion of this module, you will be able to: 
1. Enable and use the undo function 
2. Understand how the undo function affects disk space 
3. Understand how to use the redo function 

Enabling Undo 

It is beneficial to enable the undo feature as part of your global options. Similar to other undo features 
within other applications (MS Word, MS PowerPoint, etc), it allows the user to undo a saved change.  
The undo feature will put the configuration back exactly how it was before a given component/product 
was added.   
 
To activate this feature, right-click and selecting Undo in the configuration worksheet following a saved 
change. 
 
If the undo function is turned on using the associated Tools  Options  Whiteboard checkbox, 
the state at each step of the configuration is saved so you can return to the previous state.  There is a 
brief display on the status bar after you click Apply to make a change indicating undo is active.   
 
Undos are “stacked” so you can go back multiple steps.  In addition to turning the undo function on 
and off through the checkbox located on the property page, you can also set the number of steps you 
can go back. The list-box choices are 1, 2, 4, 10, or unlimited as shown in Figure 1 below. 

 
Figure 1: Enabling the undo function with a limit of 10 

 
 
Undo does not always bring the Graphic User Interface back to the previous display (the display that 
existed just prior to make the change that was just undone).   
 
The undo function ends when a Whiteboard is closed.  Thus there is no undo capability to bring back a 
closed Whiteboard. 
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Undo Function & Disk Space 

Undo also take up disk space, typically 300KB per saved state, but more for more complex 
configurations.  Each time you apply a step with the undo function turned on, the state of the 
configuration is saved.   
 
For complicated configurations, the saved system may occupy significant disk space.  If you cannot 
apply a change that can be undone because you have run out of disk space to save it, the undo 
function will automatically be turned off.  Setting the number of steps you can go back on the Tools  
Options  Whiteboard to “unlimited” or a high number can potentially be a problem.  

Note: It is recommended that you limit the size of the undo stack to 4.  This allows the user to 
undo the last four saved changes. 

When you are done with a set of potential undos for a given Whiteboard because the Whiteboard is 
closed, the disk space is freed.  The saved-undo-configuration files are saved in a “WatUndo” 
subdirectory of your designated temporary subdirectory (e.g., one named c:\temp or c:\tmp). 

Redo Function 

Redo is a companion function to undo.  The type of undo or redo is specified, if applicable.  Thus if 
one has performed the following operations (a) added a system to the Whiteboard, (b) added a 
storage enclosure, (c) added disk drives in that enclosure, and (d) Edit  Undo Worksheet apply, 
then the relevant main menu edit choices (and their right-click, context-menu equivalents) will be undo 
worksheet add and redo worksheet apply. 

Note: Redo allows a user to get back to a given undo state as long as no further changes have 
been made to the state following the redo. You can go back as far as the first undo in the 
undo stack. 

 Summary 

In this module, you have learned the following tasks: 
1. How to enable and use the undo function 
2. How the undo function affects disk space 
3. How to use the redo function 
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Saving Global Options 

Module Objectives 

Upon completion of this module, you will be able to: 
13. Access global options to set user preferences. 
14. Save global option settings when migrating to a new version of SBW. 

Accessing Global Options  

To open the Global Options window, click Tools  Options. 
 
In the Global Options dialog box you can set the following user preferences: 

 General - Click this tab to include or exclude pre-release or obsolete products in systems 
to be configured. 

 Error Notification - Click this tab to set user preferences regarding display and 
generation of errors. 

 Whiteboard - Click this tab to set user preferences for subtext under icons on the 
Whiteboard.  

For more information, see the Global Options module in the Configurator course. 

Saving Global Options 

To save global options when migrating to a new version of SBW, click Retain User Data when you 
initially install the SBW application. For more information, see the Detailed Installation course. 

Summary 

In this module, you have learned the following tasks: 
1. How to access global options to set user preferences. 
2. How to save global option settings when migrating to a new version of SBW. 
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Warranty Installation Information & Applicable Notes 

Module Objectives 

Upon completion of this module, you will be able to: 
1. Understand warranty codes from 1A-9Z and the applicable notes 
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Warranty Codes from 32-56 
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Warranty Codes from 57-77 
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Warranty Codes from 78-93 
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Warranty Codes from 94-NA 
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Applicable Notes 

 

Summary 

In this module, you have learned the following tasks: 
1. How to interpret warranty codes from and the applicable notes 
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Technical Assistance 
Technical assistance for SBW for Windows™ is available around the world by phone and e-mail.   
US & Canada Latin America Asia Pacific Japan EMEA 

SBW & WATSON SBW & WATSON SBW & WATSON SBW & WATSON SBW 
 
HP Internal Field 
Sales Reps  
 
MOPAQ 
1-877-262-6672  
 
Other Internal 
Users and 
Channel Partners  
 
NA Business Tools 
Support 
1-800-483-0160   
option 1 

 
Mexico local  
(5255) 5258-4990  
 
IDD  
+52 (55) 5258-
4990  
 
Miami direct  
(305) 265-6060  
 
Brazil direct  
(55114) 197-8612  

 
Australia  
IDD  
(61) 2-9022-9555 
 
China and Taiwan 
IDD  
(86) 10-6564-3333 
 
Other AP countries 
IDD   
(603) 2332-8833  

 
IDD  
(81) 426-39-2580  
 
0900 to 1900 Japan 
time 

 
English  
+49 7031 468 3288 
 
Español 
+49 7031 468 3285 
 
Français 
+49 7031 468 3286 
F: 0825 080 348 
 
Deutsch 
+49 7031 468 3287 
 
Italiano  
+49 7031 468 3291 
I: 0292 124 580 
 
After greeting, select 
option 2. 

    WATSON 
     

1st-level support: 
Key user in the country 
 
2nd-level support: 
Low/medium/high 
priority: e-call: http://e-
call.europe.hp.com/bltw
eb.pl?site=eaogst 
 
Critical issues that affect 
the team (Watson server 
down) Hotline +39-
035-304502 

Coverage hours Coverage Hours Coverage hours Coverage hours Coverage hours 
Monday – Friday 
8:00 am to 8:00 pm 
 
Eastern Time  
Except HP holidays 

Monday – Friday 
7:00 am - 8:00 pm 
 
Central Time 
Except HP holidays 

Monday – Friday 
6:30 am - 8:00 pm, 
 
Saturday 
3:30 am - 1:00 pm, 
Singapore Local Time 

Monday – Friday 
0900 to 1900 
 
Japan time 

Monday – Friday 
9:00 am - 6:00 pm 
 
Central European Time 

 


